
BIOL 4460/5460 and GEOL 4460 Introduction to GIS 
LAB3 - MAP PROJECTIONS 

In this exercise we will inspect different projections and how ArcGIS Pro deals with these when 
displaying geographic data on the screen. We will inspect on the distortions that projections cause 
on features when trying to project geographic data on a flat surface, and how to properly fix issues 
to minimize errors. 
 
- Download the Exercise_3.zip file from http://geo02.tamiu.edu/gis_2018. 
- Unzip the file by right-clicking, choose 7-zip and then click on Extract Here 
- Start ArcGIS Pro. Choose Blank as the project template on the right side of the screen. 
- Type Lab3 as the name for the project, and browse to your GIS_Exercises folder as the location 
for the project. Select the GIS_Exercises folder and then click OK. 

- Click on the Project tab on the upper left area of the window.  
- Click on Options, and then click on the Map and Scene section. 
- Change settings to match those of the following image. 

 
 
 
 

 

 

 

 

 

 

 

 

- Click OK on the Options window, and then click on the Back arrow on the upper left. 

This time the project does not have a map pre-built like the Lab1 project. We do not need a 
basemap for this exercise, and that is why we have changed the options above. 

- Click on the Insert tab, and then click on the New Map button. If you click the down arrow, 
make sure you click New Map, not any of the other options. 

- ArcGIS Pro creates a blank map. 



- Under folder in the Catalog pane, create a connection to the Exercise_3 folder you downloaded. 
(Right-click Folders > Add Folder Connection). 

- Add the continent.shp file to the map by dragging it to the map area. 
- Add the States3.shp file to the map 
- Read the text on the warning window. 
 

This warning will appear every time you add a layer that has a different coordinate system from the 
data frame. The data frame or current map obtains the coordinate system of the first layer that you 
added, which in this case is the continent layer. Click Cancel on the window. 
 
- In the table of contents (left pane), right-click Map under the “Drawing Order” text and then click 
on Properties. 

- Click the Coordinate Systems section. Click on Details. 

 
 
1. Record the following: 

 
Name ___________________ WKID ____________ Datum _______________ 

 
Semimajor Axis ________________________ 

 
Semiminor Axis ________________________ 

 
Inverse Flattening _______________________ 

 
- Click Cancel on the Map Properties window. 
- Double-click on the States3 layer (shortcut: this is the same as right-clicking and selecting 
Properties). 

- Click on the Source section and expand the Spatial Reference section. 
 
2. Record the following: 

 
Name ___________________ WKID ____________ Datum _______________ 

 
Semimajor Axis ________________________ 

 
Semiminor Axis ________________________ 

 
Inverse Flattening _______________________ 

 
These two datasets have coordinate systems based on different datums. The differences are 



minimum and, as you can see, ArcGIS Pro was able to still overlay the two layers correctly. This is 
called “On the fly projection.” ArcGIS Pro will try to make necessary adjustments to the datasets to 
align them. This is not a permanent modification on the datasets. It is always recommended to 
change the coordinate system of datasets so that all of them match. This is done to minimize 
alignment issues but it is more critical when performing geoprocessing operations that require 
measurements of distances and areas. We will later explore how to make layers match one another. 
 
So far we have used geographic coordinates, thus, all units are in degrees of latitude and 
longitude. We will create a 30-degree grid that covers the whole earth to inspect how shapes are 
modified to create a more realistic representation of the earth on a map using projected 
coordinate systems. 
 
- Remove the States3 layer form the map. 
- Click the Analysis tab, and then click Tools to open the Geoprocessing pane. 
- In the Find Tools search box type “grid index features”. 
- Click on the tool with this name (Cartography tools). 
- Type grid for Output Feature Class. 
- Choose 30 Decimal Degrees for Polygon Width and Polygon Height. 
 
Polygon Grid Origin Coordinate refers to the lower left corner of the group of grids to be created. 
Remember that geographic coordinates are measured right and left of the Central Meridian (X) 
and above and below of the Equator (Y). Therefore, we want our origin to be -180(X) and  
-90(Y). 
 
- Enter these values  for X and Y 
 
3. Why are these numbers negative? 

 
 
 
 
 

- Enter 6 for number of row and 12 for number of columns. 
 
4. How wide and tall is each grid in decimal degrees? _______________ 
 
- Since we are creating a new feature class from scratch, we must define a coordinate system. We 
want it to match the continent layer. Click on the Environments Section. 

 
 

- Click on the down arrow for Output Coordinate System and select continent. Click Run. 
 
 
- Change the symbology of the grid to black outline, click on Properties 
section and change the width to 1. Click Apply. 



 
5. Use the Explore tool in the Map tab, click on the grid square where Laredo is located and 

identify the following: 
 

PageName___________  PageNumber____________ 
 
-Save your project and continue to save as often as you can remember! 
 
- In the Geoprocessing pane (remember all panes remain open on the right side of the interface and 
you can switch using the tabs at the bottom), click the back arrow on the Grid Index Features tool, 
then search for “Feature to Point” and click on the tool (Data Management). 
 

 
 

- Click the down arrow for Input Features and select the grid layer. 
- In the Output Feature Class section, replace the automatically generated name with centroids. Do 
not erase the path of the database. Only replace the part after Lab3.gdb with “Centroids” 

 
- When the tool finishes running, click the back arrow and search for the tool “buffer”. 
- Open the tool (Analysis Tool). Select centroids as the Input features, and name the output circles 
(remember, only change the final name not the path). Under Distance, enter 15 and change 
Unknown to Decimal Degrees. Click Run. 

- When the tool finishes running, change the circles symbology to black outline. Since you 
previously changed symbology for the grid, the symbology will be on the Properties section. 
Change Color to black, Outline Color to No Color, and Outline width to 1.0. If you wanted to 
change to another symbol, you need to click on the Gallery section. Click Apply. 

 
 

- Deselect the centroids layer under the Contents pane. 
 
This map in its current view shows a representation of the world as if it was flat. How would the 
grid and circles change if we wanted to make them fit into a more realistic representation of the 
earth? 
 
- Double-click Map on the Contents pane. 
- Click on the Coordinate Systems section. 
- Under XY Coordinate Systems Available, expand the Projected Coordinate Systems folder, and 
then expand the World folder. 

- Select the Azimuthal Equidistant (world) option and click OK. 
- Right-click the circles layer and select Zoom To Layer. 



 
6. Deselect the circles and grid layers as needed so you can see them independently. In what 

area of the map does the least distortion occur? 
 
 
 
 
- Click on the Insert tab and select to add a new map 
- If necessary, switch to the Catalog pane. Remember all panes are open in tabs on the right side. 
- Add the States1, States2 and States3 layers. Click Cancel on the warning messages. 
 

7. Identify the coordinate system of each of the layers. 
 
States1 ____________________________  States2________________________ 
 
 
States3_____________________________ 

 
You will notice that everything seems to line up perfectly at a small scale. 

- On the Map tab, click on the Locate  button. On the Locate pane on the right side, enter 
26.111, -97.169. Click enter. 

- These are coordinates in South Padre Island. You may need to zoom out to a scale of 1:5,000. 
 

8. Turn on and off the three layers so you can analyze if they line up. Which of the layers line 
up? 

 
 
 

- On the Map tab click on the Full Extent button next to the Explore button. This button is 
useful to return the map view to show a full view of the layers present in the map. 

- Click on the Explore button and click on the small set of islands present on the far-right side of the 
map. And no the correct answer is not Hawaii. 
 

9. What state do these islands belong to? _______________________________ 
 

10. Why are these islands on the right side of the map and not attached to the rest of the state on 
the left side of the map? 
 

 
 
 
-Save you map 
 
-Once again, create a new blank map.  
-From the Exercise3 folder, add the Laredo layer, and then Campus1.tif. 
-Click on Campus1 and drag it to make sure is on top of the Laredo layer. This may take a moment, 



-Open the properties window of the Campus layer and click on the Source section. The campus 
layer does not appear in the map view. This is ok. We are about to learn why this happened. 
 

11. What is the spatial reference of the Campus layer? 
 
_______________________________________________________ 

 
-Click Cancel on the Campus1 layer properties window. 
-Right click on the Campus1 and click on Zoom To Layer. 
-Add the Campus 2, 3 and 4. Pan around the map area to see the whole image. 
 
You will notice the 4 campus images do line up with one another.  
 
-Click on the Full Extent button. 
 
Nothing appears on the map because there are images with coordinate system associated with them, 
so ArcGIS Pro cannot line them up appropriately. 

 
-Right click the Laredo layer and zoom the layer. 

-On the map tab click on the Basemap  button and select to add Imagery. 
-Click OK on the transformation window warning. 
-Locate the Lake Casa Blanca on the map, and use the mouse scroll button to zoom in to the 
TAMIU campus area (move the scroll button forward). Zoom in enough to see the entire campus. 

 
We need to define the projection of the Campus images, but first we need to stitch them together. 
 
-Open the Geoprocessing pane (Analysis Tab). Search for and open “Mosaic to New Raster”. 
- For Input Rasters select one by one each of the Campus images by clicking the drop down arrow. 
-In Output location, click on the browse button and select your Exercise3 folder. 
-For Raster Dataset Name with Extension type “TAMIU.tif” 
-Type 3 in the Number of Bands section and click Run. The tool will take a couple of minutes to 
run. 

 
When the tool finishes running, you will still not see the TAMIU layer on the map. 
 
Many times, the originator of the data has information about the projection that was utilized to 
construct it. Other times, you have to try to find the correct projection by trial and error. For this 
case, we are going to pretend the originator of the campus image used a State Plane projection 
and that is all the information we have. We need to modify the current map projection until the 
campus image fits into the area where it is supposed to be. 
 
-Right click the Map2 under The Table of Contents and click on the Coordinate System section. 
-We know the campus image uses a State Plane projection. Under the XY Coordinate Systems 
Available, expand the Projected coordinate system section and then expand the State plane section. 

 
We need to try the Texas South Central (FIPS 4205) and Texas S Central (FIPS 4204) under the 
following sections: 

 



NAD 1983 (Meters) 
NAD 1983 (US Feet) 
 
-To choose a projection, click on the Name of the projection and then click OK on the Map2 
properties window. 

-If you get a warning message click Cancel. 
-If the current projection you chose matches that of the campus image, it will appear aligned with 
the Basemap imagery. If nothing happens, go back to the properties window and select the next 
one. 

-Once you identify the correct projection, make a note of it. 
 
12. Correct projection: ________________________________________ 
 
Now that we have found the correct projection, we need to assign it to the layer. 
 
-Type “Define Projection” Geoprocessing pane, click on the tool (Data 
  Management). 
-For input dataset choose the TAMIU layer. 
-Click on the drop down arrow for Coordinate System and select Current Map [Map2] to use the   
State Plane projection that the map is currently using. 
-Click Run. 
 
When the tool finishes running open the properties of the TAMIU layer and check the Source 
section to verify that the coordinate system has been applied. 
 
Save your project and close ArcGIS Pro, 
 
 

 

Examine the following maps and determine propert(ies) preserved (conformal, equivalence, 
equidistance, azimuthality, none) and class of projection (conic, cylindrical, psuedo-cylindrical, 
or azimuthal). Hint: refer to USGS map projection guide. 
(http://egsc.usgs.gov/isb//pubs/MapProjections/projections.html) 

13.  

       Property Preserved 

 

       __________________________ 

 

       Projection Class 

 

       __________________________ 



 

14.        Property Preserved 

 

       __________________________ 

 

       Projection Class 

 

       __________________________ 

Hint: This projection is used in one of the Planar Coordinate Systems discussed in lecture 2. 
Note that this map represents six degrees of longitude. 

15. 

        Property Preserved 

 

 

       __________________________ 

 

       Projection Class 

 

 

       __________________________ 

 

16.  

 

 

 

 

 

 

 



 

 

 

 

Property Preserved  __________________ Projection Class  ______________________ 

 

 

17.  

 

 

 

 

 

 

 

 

 

Property Preserved  __________________ Projection Class  ______________________ 

 
 
 
BIOL 4460/5460 and GEOL 4460 Introduction to GIS 
ASSIGNMENT 3 – ANSWER SHEET   Name: ____________________ 
 
1. Record the following: 

 
Name ___________________ WKID ____________ Datum _______________ 

 
Semimajor Axis ________________________ 

 
Semiminor Axis ________________________ 

 
Inverse Flattening _______________________ 

 
2. Record the following: 

 



Name ___________________ WKID ____________ Datum _______________ 
 

Semimajor Axis ________________________ 
 

Semiminor Axis ________________________ 
 

Inverse Flattening _______________________ 
 
3. Why are these numbers negative? 

 
 
 
 
 

4. How wide and tall is each grid in decimal degrees? _______________ 
 
5. Use the Explore tool in the Map tab, click on the grid square where Laredo is located and 
identify the following: 
 

PageName___________  PageNumber____________ 
 
6. Deselect the circles and grid layers as needed so you can see them independently. In what area of 
the map does the least distortion occur? 
 
 
 
 
 
 
 
 
7. Identify the coordinate system of each of the layers. 

 
States1 ____________________________  States2________________________ 
 
 
States3_____________________________ 

 
8. Turn on and off the three layers so you can analyze if they line up. Which of the layers line up? 
 
 

 
 
9. What state do these islands belong to? _______________________________ 

 
10. Why are these islands on the right side of the map and not attached to the rest of the state on the 
left side of the map? 
 
 



 
 
11. What is the spatial reference of the Campus layer? 
 
 
 

 
 
12. Correct projection: ________________________________________ 
 
 

13. Property Preserved  __________________ Projection Class ______________________ 

 

14. Property Preserved  __________________ Projection Class ______________________ 

 

15. Property Preserved  __________________ Projection Class ______________________ 

 

16. Property Preserved  __________________ Projection Class ______________________ 

 

17. Property Preserved  __________________ Projection Class ______________________ 

 


